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CHAPTER 1

Introduction
DotNet Help is a Help output format developed by MadCap Software for Windows desktop applications. It was designed to include the best attributes of Microsoft HTML Help and WebHelp, while
filling the holes left behind by those formats. DotNet Help is designed specifically to support Visual
Studio developers. It includes a freely redistributable viewer (MadCap Help Viewer), as well as components for the Visual Studio developer. These components can be dropped into your Flare project
to facilitate context-sensitive Help, embedded Help, and features such as automated search string
communication between the application and the DotNet Help documentation.
The output consists of a collection of files that you will distribute to users with the freely downloadable MadCap Help Viewer. The main entry file has an .mchelp extension.
Following are some of the key features of the DotNet Help format:
n

.NET Application Support

n

Accessible This is a good choice if you do not want users to be burdened by the security warnings and limitations that are often encountered with Microsoft HTML Help and WebHelp.

n

Customizable/Modern Interface You can produce a customizable interface that is much
more modern looking than the aging Microsoft HTML Help. It will blend easily into a modern
environment.

n

Embedded Context-sensitive Help (CSH) You can create embedded CSH in a .NET application. This includes the ability to produce Dynamic Help.

n

Multiple Languages Users can select between multiple languages for the interface when viewing your output. This is possible because the freely distributable MadCap Help Viewer lets
users select English, French, German, or Japanese for the interface.

n

Boolean Operator and Asterisk (*) Wildcard Character Searches These are supported when
SQL Compact is installed on the local computer building the Help.
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CHAPTER 2

Runtime Merging Output
Use this merging method if you are developing DotNet Help and you want to merge the output files
from your parent project with the DotNet Help output files from an external project. This method is
useful, for example, if another author is working on the external DotNet Help project to which you
are linking and you only have access to the output files (not the project files).

NOTE: There are occasions when projects cannot be merged because the file name is the
same in two or more of the linked projects (e.g., multiple DotNet Help projects all named
"MyDotNetProject.mchelp," multiple WebHelp projects all named "MyWebProject.mcwebhelp," or multiple Microsoft HTML Help projects all named "MyHtmlHelp.chm"). The way to solve this dilemma is to make sure each linked project has a
different output file name. To do this: (1) open the target, (2) select the General tab in the
Target Editor, and (3) enter a unique name in the Output File field.
Before your master project can be merged with an external Help system, the output folders and files
for the external (or "child") project need to be copied to a folder called "Subsystems" in the same location where the master project is being published. The child's target folder containing these output
files also needs to be included at this location.
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EXAMPLE
Let's say the master project's output files are being published to the following:
C:\MyHelpSystem\Master\Master.mchelp

In that case, the output folders and files for the child project should be copied to the following folder:
C:\MyHelpSystem\Master\Subsystems

For example:
C:\MyHelpSystem\Master\Subsystems\AnotherHelpSystem\AnotherHelpSystem.mchelp

In this example, "AnotherHelpSystem" is the target folder that you generated, which
holds the output folders and files, and "AnotherHelpSystem.mchelp" is the main output
file for the child project that was created. Not only does the main .mchelp output file
need to be included in this folder, but also the ancillary output folders and files (e.g.,
Content, Data).
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You can merge DotNet Help outputs using an automatic or manual method.

HOW TO MERGE OUTPUT FROM DOTNET HELP PROJECTS (AUTOMATIC METHOD)
1. Generate the output for the child project.
2. Open the TOC in the Flare project that will serve as the parent project.
NOTE: You can also merge projects by linking them from a browse sequence, as well
as from a TOC. If you want to do this, simply follow these same steps after opening
your browse sequence.
3. In the TOC Editor, select the TOC entry or book where you want to link the output from the
child DotNet Help project. (The TOC of the linked project will be inserted at that spot in the parent TOC.)
4. In the local toolbar of the TOC Editor, click

. The Properties dialog opens.

5. Click Enter External Help System. The Link to Help System dialog opens.
6. Click Browse.
7. In the Files of type field, click the down arrow and select MadCap DotNet Help Files
(*.mchelp). Then find and select the MCHELP output file to which you want to link.
8. Click OK. The full path to the file is displayed in the field.
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9. (Optional) If you want the merged TOC to replace the entry that you selected, do the following.
a. Select the Advanced tab.
b. Click the check box labeled When merging, replace node with merged TOC.
For example, you might have a TOC in your master project that looks like this:
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If you select the option in this step to replace the node, the merged TOC would look like this in
the output:

And if you do not select this option, your merged TOC would look like this:

10. In the Properties dialog, click OK.
11. Build the output for the DotNet Help target in your "master" project.
Flare automatically creates the Subsystems folder for you. It also copies the target folder and
.mchelp file (along with the ancillary output files and folders) to the appropriate
destination. When you open the TOC in the output, you will see the integrated TOC from the
linked project.
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HOW TO MERGE OUTPUT FROM DOTNET HELP PROJECTS (MANUAL METHOD)
1. Generate the output for the child project.
2. Open the TOC in the Flare project that will serve as the parent project.
3. In the TOC Editor, select the TOC entry or book where you want to link the output from the
child DotNet Help project. (The TOC of the linked project will be inserted at that spot in the parent TOC.)
4. In the local toolbar of the TOC Editor, click

. The Properties dialog opens.

5. Click Enter External Help System. The Link to Help System dialog opens.
6. Type the name of the child target and main output file (e.g., AnotherHelpSystem/AnotherHelpSystem.mchelp).
7. Click OK.
8. (Optional) If you want the merged TOC to replace the entry that you selected, do the following.
a. Select the Advanced tab.
b. Click the check box labeled When merging, replace node with merged TOC.
For example, you might have a TOC in your master project that looks like this:
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If you select the option in this step to replace the node, the merged TOC would look like this in
the output:

And if you do not select this option, your merged TOC would look like this:

9. In the Properties dialog, click OK.
10. Build the output for the DotNet Help target in your "master" project.
11. In the master Flare project, right-click on the target and select Open Output Folder. Within
that folder, manually create another folder and name it Subsystems.
12. In the child Flare project, select Project > Open Output Folder (if using the ribbon view) or Build
> Open Output Folder (if using the menu view).
13. Copy the target folder to be merged with the master project.
14. Paste the target folder within the Subsystems folder that you created in the master output
folder.
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NOTE: If you merge projects, synonym files will remain separate in each project. For
example, if you create synonyms in Project A but not in project B, only the topics from Project A will use the synonyms when users perform searches in the output.
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CHAPTER 3

CSH Calls for DotNet Help
There are several ways that your Flare DotNet Help system can be "connected" to a software application.
This chapter discusses the following:
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Available DotNet Help Features in Flare
Features that are available include the following.
n

Detached or Integrated Help The Help system can be connected so that the Help opens in a
window separate from your software application (detached Help).
Alternatively, the Help can be connected so that the Help opens within the software application (integrated Help).

n

Same or Different Process The Help system can be connected so that it uses the same process as the software application (embedded). If the Help uses the same process, the Help will
close when the application is closed. The online Help in Flare is connected so that it uses the
same process as Flare. Alternatively, the Help system can be connected so that it uses a different process than the software application. If the Help uses a different process, the Help
can remain open even if the application is closed.

n

Basic Help or Context-sensitive Help (CSH) The developer can connect the application to your
basic DotNet Help output, rather than to a specific topic. For example, you might want a standalone version of the Help Viewer to open separately from the software application, displaying
your startup topic and showing panes for the navigation elements (e.g., TOC, Index, Search,
Browse Sequences) that you have created. Or maybe you want users to be able to open the
different navigation elements within the application and access topics from each one.
Alternatively, the developer can use CSH to connect the application to specific topics in the
DotNet Help output (as long as you have created CSH in your Flare project and share the
header file information with the developer).

n

Dynamic Help The developer can also incorporate your Help into the application using a
unique feature called "Dynamic Help." This is a type of CSH where a Help window automatically displays topics from a Help system as an individual uses the application. It does not
require any other action from the user (e.g., clicking a button or pressing a shortcut key). The
Help system simply follows the actions of the user, automatically providing the appropriate
Help content based on the area of the interface that is being clicked.

n

F1 Help The developer can connect the application to the Help in such a way that the Help
opens when a user presses the F1 key.

n

Dialog's Help Button The developer can connect the application to the Help in such a way that
the Help opens when a user clicks the dialog's Help button (i.e., the "question mark" button).
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What You Need to Do
1. Work with your developer to determine which of the above features you want to use. You may
want to use several of the features, as is the case with the Flare's online Help.
2. Create and build your DotNet Help project in Flare.
3. Provide the developer with the output files, as well as the CSH header file (if you plan to use
CSH).
4. Provide the developer with the information in the following topics. The developer should begin
with the "CSH Calls for DotNet Help—Developers" topic.
n

"CSH Calls for DotNet Help—Developers" on the next page

n

" HelpViewerClient API" on page 19

n

" HelpViewerEmbeddedClient API" on page 21

n

" IEmbeddedHelpSystem API" on page 24

n

"ICSHIDProvider API" on page 27

n

"Command Line" on page 29
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CSH Calls for DotNet Help—Developers
Information for Developers
There are three ways to make DotNet Help calls from your Windows application. The most basic
way is to use the command line functionality of the DotNet Help Viewer (see "Command Line" on
page 29). The other two ways are to use the HelpViewerClient (HVC) (see " HelpViewerClient API" on
page 19) and HelpViewerEmbeddedClient (HVEC) (see " HelpViewerEmbeddedClient API" on page
21) classes. Use the command line version only if your application doesn't have access to the latest
.NET framework. Otherwise, you should use one of the other two methods.

Features of the DotNet Help CSH Engine
n

Open a topic of your choice in the MadCap Help Viewer.

n

Launch a Help system with the search results from a search string that you specify.

n

Embed Help topics or search results directly into your application.

n

Dynamic Help—A Help window automatically shows relevant information based on the user's
focus in your application.

Key Differences between the HVC and HVEC Classes
n

HVC only supports basic, non-embedded CSH calls. It also does not provide Dynamic Help
functionality.

n

HVEC contains built-in functionality for F1 help. F1 help is still possible with HVC, however the
developer must manually handle the user pressing the F1 key.

n

HVC opens the Help Viewer in a separate process from your application, whereas HVEC opens
the Help Viewer in the same process as your application. This means that with HVC, if your
application closes, the Help window will remain open. On the other hand, with HVEC, if your
application closes, the Help window will also close.
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Using the API
You can download the Help Viewer SDK at:
http://www.madcapsoftware.com/downloads/redistributables.aspx
You must add a reference to the appropriate DLL in your project to use the API.
In Visual Studio 2005, do the following.
1. In the Solution Explorer, right-click the project.
2. Click Add Reference.
3. Select the Browse tab.
4. Navigate to the appropriate .dll file and select it:
n

Select MadCap.HelpViewerClient.dll to use the HelpViewerClient API.
OR

n

Select the MadCap.HelpViewerEmbeddedClient.dll to use the HelpViewerEmbeddClient
API.

5. Click OK.

Sample Applications
There are two sample applications available in the SDK that demonstrate using the HelpViewerClient and HelpViewerEmbeddedClient classes.
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Distribution
Help Viewer must be installed on the user's machine that is using your application. The SDK contains a merge module that you can incorporate into an MSI-based installer to distribute the Help
Viewer.
The following are instructions on how to include the merge module using Visual Studio 2005.
1. In the Solution Explorer, right-click the MSI installer project.
2. Click Add.
3. Click Merge Module.
4. Browse to the InstallMadCapHelpViewer.msm file and select it.
5. Click Open.

Search Performance and Wildcards
When SQL Server Compact 3.5 SP1 is present, Help Viewer can use it to improve search performance and also allow wildcard searching. To take advantage of these capabilities, you can
include SQL Server Compact 3.5 SP1 as part of your application's installation. For more information
regarding SQL Server Compact 3.5 SP1 including redistribution rights, please visit:
http://www.microsoft.com/Sqlserver/2008/en/us/compact.aspx
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HelpViewerClient API
Information for Developers
The HelpViewerClient API is used to make DotNet Help calls, including context-sensitive Help (CSH)
calls. HelpViewerClient only supports basic, non-embedded calls. It also does not provide Dynamic
Help functionality. The HelpViewerClient API will open the Help Viewer in a separate process from
your application.
If instead you require integrated Help, Dynamic Help, or opening the Help Viewer in the same process as your application, see " HelpViewerEmbeddedClient API" on page 21.

HOW TO USE THE HELP VIEWER CLIENT API
1. Create an instance of the class using the constructor.
2. Call Load() or TryLoad() to load the Help system of your choice.
3. Call Search() or ShowTopic(). The first time either of these two methods are called, a new
Help Viewer window will be launched. Every call after that will open the desired topic or search
results in the existing Help Viewer window.
Name
public void

Description
Creates an instance of the HelpViewerClient.

HelpViewerClient

()
public void
Load( string
helpsystem )

Loads the Help system at the path specified in the helpsystem parameter.
This method must be called once before calling Search() or ShowTopic(). If
the Help system does not exist, an ArgumentException is thrown. See also
TryLoad().

public void
Search( string
searchString )

Performs a search for the string specified in the searchString parameter.
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Name

Description

public void
Search( string
searchString,
string cshid )

Performs a search for the string specified in the searchString parameter.
The cshid parameter is used to override the default starting topic of the
Help system. This can be either the identifier name or value. Alternatively,
the ID may contain a topic path. When using a topic path, it must be relative
to the Content folder of the Help system.

public void
( string
cshid )

Opens the Help system with the topic specified in cshid. This can be either
the identifier name or value. Alternatively, the ID may contain a topic path.
When using a topic path, it must be relative to the Content folder of the Help
system.

public bool
TryLoad( string
helpsystem )

See Load(). This method is equivalent to the Load() method. However,
instead of throwing an exception, it returns true if the Help system was
loaded successfully; it returns false otherwise.

ShowTopic

EXAMPLES
Refer to the sample application called "HelpViewerClientTester" for a fully functional
application that uses the HelpViewerClient API. This sample application is available in
the SDK, which you can download from:
http://www.madcapsoftware.com/downloads/redistributables.aspx
HelpViewerClient client = new HelpViewerClient();
if ( client.TryLoad( @"C:\My Project\Manual.mchelp" ) )
{
client.ShowTopic( "MyID1" );
}
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HelpViewerEmbeddedClient API
Information for Developers
The HelpViewerEmbeddedClient API is used to make calls to the DotNet Help system, including context-sensitive Help (CSH) calls. This API supports embedded CSH calls and can also provide
Dynamic Help functionality. When you use this API, the MadCap Help Viewer opens in the same process as your application. If instead you require detached Help, opening the Help Viewer in a separate process from your application, see " HelpViewerClient API" on page 19.

HOW TO USE THE HELP VIEWER EMBEDDED CLIENT API
1. Create an instance of the class using the constructor.
2. Call Load() or TryLoad() to load the Help system of your choice.
3. Use the functionality of the Help System object.
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Name

Description

public void HelpViewerEmbeddedClient()

Creates an instance of the HelpViewerEmbeddedClient.

public void HelpViewerEmbeddedClient(
string title )

Creates an instance of the HelpViewerEmbeddedClient. Sets the
title of the Help system to the string specified in title.

public void HelpViewerEmbeddedClient(
string title, Icon
icon )

Creates an instance of the HelpViewerEmbeddedClient. Sets the
title of the Help system to the string specified in title. Sets the
icon of the help system to the icon specified in icon.

public void Load(
string helpsystem )

Loads the Help system at the path specified in the helpsystem
parameter. This method must be called once before calling
Search() or ShowTopic(). If the Help system does not exist, an
ArgumentException is thrown. See also TryLoad().

public bool TryLoad
( string helpsystem )

See Load(). This method is equivalent to the Load() method.
However, instead of throwing an exception, it returns true if the
Help system was loaded successfully; it returns false otherwise.

public IEmbeddedHelpSystem HelpSystem

Gets an interface to the Help system. See " IEmbeddedHelpSystem API" on page 24 for more information.

public virtual string

Gets the title of the Help system.

Title
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EXAMPLES
Refer to the sample application called "HelpViewerEmbeddedClientTester" for a fully
functional application that uses the HelpViewerEmbeddedClient API. This sample
application is available in the SDK, which you can download from:
http://www.madcapsoftware.com/downloads/redistributables.aspx
// Create a group box where the embedded help topic will
be displayed
GroupBox mTopicPanel = new GroupBox();
mTopicPanel.Location = new System.Drawing.Point( 32, 204
);
mTopicPanel.Name = "mTopicPanel";
mTopicPanel.Text = "Help Topic";
// Display a topic embedded in the group box
HelpViewerEmbeddedClient client = new HelpViewerEmbeddedClient();
if ( client.TryLoad( @"C:\My Project\Manual.mchelp" ) )
{
client.HelpSystem.DynamicHelpPanel = mTopicPanel;
client.HelpSystem.LoadTopic( "MyID1" );
}
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IEmbeddedHelpSystem API
Information for Developers
The IEmbeddedHelpSystem API is an interface that exposes functionality for context-sensitive Help
(CSH), embedded Help, and Dynamic Help.

Detached CSH
To launch the Help system in a separate Help Viewer window, use the ShowHelp() method.
To make a CSH call and have the results displayed in a separate Help Viewer window, use the
ShowTopic() method.
To display search results from a Help system in a separate Help Viewer window, use the Search()
method.
These methods will launch an instance of the Help Viewer application. It will be launched in the
same process as your application so when the user closes your application, the Help Viewer will also
be closed.

Embedded CSH
To embed a topic from your Help system into your application, use the LoadTopic() method.
To embed search results from your Help system into your application, use the EmbeddedSearch()
method.
You must set the DynamicHelpPanel property prior to calling LoadTopic(). Similarly, you must set
the SearchPanel property prior to calling EmbeddedSearch().
EXAMPLES
Refer to the sample application called "HelpViewerEmbeddedClientTester." This
sample application is available in the SDK, which you can download from:
http://www.madcapsoftware.com/downloads/utilities/redistributables.aspx
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Dynamic Help
Dynamic Help is a feature where a Help window automatically displays topics from a Help system
that are relevant to the context as an individual uses an application. For example, if the user clicks
on an area of your UI called "Project Organizer," the topic pertinent to the Project Organizer opens.
You can see an example of Dynamic Help in Flare's online Help (select Help > Dynamic Help).
To use this functionality, you must set the EnableDynamicHelp property to true. The CSH engine
needs a way to determine the appropriate topic to display. Your application can supply this information in either of two ways.
n

One way is to implement the ICSHIDProvider interface. For more information see "ICSHIDProvider API" on page 27.

n

The other way is to set the control's Tag property to the desired CSH ID string. In this case,
you must prefix the string with "CSH:"
For example, if your CSH ID is "MyHelpTopic," you would set the Tag object to the string
"CSH:MyHelpTopic."
Name

Description

public void EmbeddedSearch
( string searchString )

Performs a search for the string specified in the
searchString parameter. Displays the results embedded
in the control that is set as the SearchPanel property.

public void EnableHelpButton
( System.Windows.Forms.Form
form )

Enables the Help button in the form specified in form.
See "ICSHIDProvider API" on page 27 if you are enabling
this feature.

public void LoadTopic( string
cshid)

Loads the topic specified in cshid. This can be either the
identifier name or value. Alternatively, the ID may contain a topic path. When using a topic path, it must be relative to the Content folder of the Help system. Displays
the topic embedded in the control that is set as the
DynamicHelpPanel property.

public void Search( string
searchString )

Performs a search for the string specified in the
searchString parameter. Displays the results in a new
Help Viewer window.
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Name

Description

public void Search( string
searchString, string cshid )

Performs a search for the string specified in the
searchString parameter. The cshid parameter is used to
override the default starting topic of the Help system.
This can be either the identifier name or value. Alternatively, the ID may contain a topic path. When using a
topic path, it must be relative to the Content folder of
the Help system. Displays the results in a new Help
Viewer window.

public void ShowHelp()

Opens the Help system in a new Help Viewer window.

public void ShowTopic( string
cshid )

Opens the Help system with the topic specified in cshid.
This can be either the identifier name or value. Alternatively, the ID may contain a topic path. When using a
topic path, it must be relative to the Content folder of
the Help system.

System.Windows.Forms.Control

Gets or sets the control where the embedded Help topic
will be loaded. This must be set before calling
LoadTopic().

DynamicHelpPanel

bool EnableDynamicHelp

Gets or sets whether Dynamic Help is enabled for the
form. See "ICSHIDProvider API" on the next page if you
are enabling this feature.

bool EnableF1Help

Gets or sets whether F1 Help is enabled for the form.
See "ICSHIDProvider API" on the next page if you are
enabling this feature.

System.Windows.Forms.Control

Gets or sets the control where the embedded Help
search results will be loaded. This must be set before
calling EmbeddedSearch().

SearchPanel
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ICSHIDProvider API
Information for Developers
The ICSHIDProvider API is used to enable a System.Windows.Forms.Control to be a context-sensitive Help (CSH) ID provider. This is required to incorporate any of the following.
n

Dynamic Help This is a feature where a Help window automatically displays topics from a
Help system that are relevant to the context as an individual uses an application. For example,
if the user clicks on an area of your UI called "Project Organizer," the topic pertinent to the Project Organizer opens. You can see an example of Dynamic Help in Flare's online Help (select
Help > Dynamic Help).

n

F1 Help This is a feature where the Help opens when a user presses the F1 key.

n

Dialog's Help Button This is a feature where the Help opens when a user clicks the dialog's
Help button (i.e., the "question mark" button).

If your application uses any of these features, the DotNet CSH engine uses this interface to determine the desired topic to display. As an alternative to implementing this interface, you may also set
the control's Tag property to the desired CSH ID string. In this case, you must prefix the string with
"CSH:"

EXAMPLE
For example, if your CSH ID is "MyHelpTopic," you would set the Tag object to the string
"CSH:MyHelpTopic"

Name
public string HelpSystemCSHID

CHAPTER 3
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The following shows how to implement the ICSHIDProvider interface.
public class MyTextBox : TextBox, ICSHIDProvider
{
private string mHelpSystemCSHID = "TestID1";
public string HelpSystemCSHID
{
get { return mHelpSystemCSHID; } }
...
}
The following shows how to set the Tag object.
TextBox myTextBox = new TextBox();
myTextBox.Tag = "CSH:TestID1";
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Command Line
Information for Developers
Following is an explanation of how to use the command line options of the MadCap Help Viewer
application. Use this method only if your application does not have access to the latest .NET framework. Otherwise, use either the HelpViewerClient API or HelpViewerEmbeddedClient API. See "
HelpViewerClient API" on page 19 and " HelpViewerEmbeddedClient API" on page 21.

Command Line Syntax
HelpViewer.exe -file [path to help system] -cshid [identifier] -search [search_string]
Parameter

Description

file

Path to the DotNet Help output file (.mchelp extension)

cshid

CSH ID of the desired topic to display. This can be either the identifier name or value.
Alternatively, the ID may contain a topic path. When using a topic path, it must be relative to the Content folder of the Help system.

search

Search string that the Help system will automatically search for when it is opened
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The following opens the specified Help system.

>HelpViewer.exe -file "C:\My Help System\Manual.mchelp"
The following opens the specified Help system and opens the topic associated with "MyID."

>HelpViewer.exe -file "C:\My Help System\Manual.mchelp" cshid MyID
The following opens the specified Help system and opens the topic located at MyTopic.htm.

>HelpViewer.exe -file "C:\My Help System\Manual.mchelp" cshid MyTopic.htm
The following opens the specified Help system and displays search results for "bikes and trikes."

>HelpViewer.exe -file "C:\My Help System\Manual.mchelp" search "bikes and trikes"
The following opens the specified Help system, opens the topic associated with "MyID," and displays
search results for "bikes and trikes."

>HelpViewer.exe -file "C:\My Help System\Manual.mchelp" cshid MyID -search "bikes and trikes"
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
Tripane and PDF Tutorial
USER GUIDES

Accessibility Guide

Getting Started Guide

Analysis and Reports Guide

Global Project Linking Guide

Architecture Guide

HTML Help Guide

Autonumbers Guide

HTML5 Guide

Condition Tags Guide

Images Guide

Context-sensitive Help Guide

Importing Guide

DotNet Help Guide

Index Guide

Eclipse Help Guide

Key Features Guide
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Language Support Guide

Source Control Guide: Git

MadCap Central Integration Guide

Source Control Guide: Perforce

Movies Guide

Source Control Guide: Subversion

Navigation Links Guide

Source Control Guide: Team Foundation Server

Plug-In API Guide

Styles Guide

Print-based Output Guide

Tables Guide

Project Creation Guide

Tables of Contents Guide

Pulse Guide

Targets Guide

QR Codes Guide

Templates Guide

Reports Guide

Topics Guide

Reviews & Contributions Guide

Touring the Workspace Guide

Search Guide

Transition From FrameMaker Guide

SharePoint Guide

Variables Guide

Skins Guide

WebHelp Outputs Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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